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Chapter 2 - Introduction 

The DDCTool 4.x is a commissioning and maintenance tool for single 
DDC (Digital Drive Controller). 

The PC where the DDCTool runs is connected optically to one DDC 
by means of the optic data communications board (SNAT624 PC 
card). 

The DDCTool program can be used with the following DDC types: 

− ACV 700 

− DCV 700 

− DCF 500 / 700 

− DCS 500 

− TSU 

The program automatically recognises the type of the DDC it is 
connected to. When the DDCTool is connected to DCS 500, then the 
DDCTool works as described in the CMT / DCS 500 User's Manual. 
This manual (DDCTool 4.0 User's Manual) describes the operation of 
the DDCTool when it is connected to one of the DDC mentioned 
above, other than DCS500 based unit. 

The following functions can be performed by using the DDCTool: 

− monitoring of the DDC's actual values in real time (min sample 
interval is 3 ms) in the graphical and numeric form 

− setting of the DDC's parameters and other values 

− display of schematic diagrams with real time monitoring of the 
DDC’s actual values 

− control of the DDC's data logger operation and display of the 
sample values collected by the data logger in graphical and 
numeric form 

− saving of the current measurement configuration and the 
screen's graphical display to a disk file 

− local control of the DDC 
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− display and clear of the contents of the DDC's fault logger 

− uploading/downloading of all DDC's parameters; changing their 
values and saving/restoring them to/from a disk file 

− testing of the I/O connections (ACV 700 only) 
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Chapter 3 - Installation of the DDCTool 4.x describes the installation 
of the DDCTool hardware and software in single DDC configurations. 

Chapter 4 - Using the DDCTool describes the basic functions of the 
DDCTool program. 

Chapter 5 - File describes how you can save and open graph and 
configuration information. 

Chapter 6 - ActValues describes how you can monitor actual values 
in the graphical and numeric form. 

Chapter 7 - Params describes how you can upload, download, save, 
open, print, compare and update the whole parameter set of the DDC 
and how you can change values of individual parameters. 

Chapter 8 - Diagrams describes how you can display schematic 
diagrams with real time monitoring of the DDC’s actual values. 

Chapter 9 - DataLogger describes how you can define the data logger 
channels and other data logger control parameters and how you can 
upload, display and save the collected data logger samples. 

Chapter 10 - Control describes how you can control the DDC in local 
control mode. 

Chapter 11 - Faults describes how you can upload, display and save 
the content of the fault logger. 

Chapter 12 - Other describes the rest of the DDCTool functions (e.g. 
use of reference graphs, window calculator and value change lock). 

Chapter 13 - Exit tells how you exit the DDCTool program. 

Appendices 1 ... 3 describe the startup parameters, error messages 
and monitoring of actual values of APC(s). 

About this Manual 
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Chapter 3 - Installation of the DDCTool 4.x 

The DDCTool is designed to run under the Microsoft Windows NT 
and 2000. Please ask for newer Windows versions. 

Please see “DDCTool V4.x Installation Instructions”, 
3adw000175R0201 (or later). 
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Chapter 4 - Using the DDCTool 

The program is started by double clicking the DDCTool 4.0 shortcut. 

If the DDC connection is not working properly then a "Cannot start 
drive communication" error box will appear on the screen (see 
Chapter Installation of the DDCTool / Troubleshooting). 
If error message "PC OVERLOAD" appears on the screen (or 
DDCTool fails during parameter upload) then you must increase the 
value of the startup parameter M (see Appendix 1). 
NOTE: If your PC includes a Power Management feature then turn it 
off and restart the program without changing the M parameter. 

 

 

Figure 4 - 1. Screen layout of the DDCTool. 

If the PC is directly connected to a DDC then the text Single DDC 
appears on the top of the screen. 

Starting the 
DDCTool 

Screen Layout of 
the DDCTool 
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The actual values to be monitored in real time (in the numeric form) 
are displayed in the upper part of the screen.  

In the middle of the screen there is a graphical display area with scale 
lines. 

On the STATE line above the graphical display area, the following 
DDC status information is displayed: 

− control mode (remote / local control) (see Chapter Control) 

− data logger state (sample values are readable / cannot be read) 
(see Chapter DataLogger) 

− fault state (fault or alarm / no fault or alarm). The fault and/or 
alarm code that was last in the DDC can be read by means of 
the Read Last Fault/Alarm Codes or Upload Fault Logger 
command in the Faults menu (see Chapter Faults). 

 

If the DDC connection does not exist then it is possible to perform 
only such operations that do not need communication with the DDC. 

 

If there is a CONFIG.QDC file (see Chapter File / Save Configuration) 
in the DDCTOOL 4.0 directory or in the “Start in” subdirectory then 
the settings in this file are automatically copied to the initial 
configuration settings of the DDCTool program. 
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If you define Value4 = signal 101-04 (MAIN_STATUS_WORD) then 
the status information of this ACV 700 signal is shown on the right 
side of the screen (gray text = inactive state): 

 

Figure 4 - 2. ACV 700 status panel on the right side of the screen. 

Status Panel 

ACV 700 
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If you define Value4 = signal 101-05 (AUX_STATUS_WORD) then 
the status information of this ACV 700 signal is shown on the right 
side of the screen (gray text = inactive state): 

 

Figure 4 - 3. ACV 700 status panel on the right side of the screen. 
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If you define Value4 = signal 101-04 (MAIN_STATUS_WORD) then 
the status information from the DC drive is shown on the right side of 
the screen (gray text = inactive state): 

 

Figure 4 - 4. DC status panel on the right side of the screen. 

DC Drives 
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The actual values to be monitored in real time are selected with the 
Object push button and with the Value1, Value2, Value3 and Value4 
push buttons. The push buttons have the following differences: 

 

       Object push button        Value push buttons 

Updating interval = the DDC 
message interval (see Appendix 1, 
parameter M). The minimum is the 
message processing interval of 
the DDC (over 20 ms). 

Updating interval = the DDC 
message interval (see Appendix 
1, parameter M). The minimum 
is 3 ms. 

The value as such is the actual 
value. 

The value can also be the 
difference between two actual 
values (or between an actual 
value and a constant value). 

The value of an object selected 
with a push button can be 
changed with the ObjVal push 
button. 

Values cannot be changed. 

During some push button and 
menu functions, a value can be 
momentarily other than the correct 
value . 

The value is always correct. 

 

The Object push button is generally used only for selecting objects 
whose contents are to be changed. The Value push buttons are used 
to select actual values that are to be monitored numerically and/or 
graphically. 

The current definitions of the above mentioned push buttons can be 
displayed on the screen by using the F9 function key (or by selecting 
the command Show Descriptions in the ActValues menu). 

Numeric 
Monitoring of 
Actual Values 
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After the Object push button has been clicked, a dialog box is 
displayed on the screen. 

 

Figure 4 - 5. Defining the Object push button (ACV 700). 

From the list one of the following actual values can be selected for 
monitoring: 

− a pre-programmed actual value. The names and display formats 
of these actual values are pre-defined, and because these 
values are calculated by the DDC, they cannot be changed with 
the DDCTool program.  

− a parameter or signal. With the List push button you can select 
the desired parameter or signal from the parameter/signal list 
(either with a double click of the mouse or by pressing the space 
bar). 

Object Push 
Button 
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When the selection has been made, click the OK push button. The 
name of selected parameter/signal will be displayed at the right side 
of the Object push button and at the right side of the ObjVal push 
button there will appear the actual value of the selected object 
(selection of the actual value's display format is explained below in 
Chapter Changing Values). 

By clicking on the object name (at the right side of the Object push 
button) the Object Selection List window can be displayed. 

 

Figure 4 - 6. Object Selection List. 

If you click on a list item (parameter/signal) then this item will be the 
new object. 

If you double click on a list item then this item will be the new object 
and the value change dialog box is automatically displayed for value 
change (see below Chapter Changing Values). 

By means of the Add push button you add new items to the end of 
the item list. 
You can select one or more parameters/signals from the dialog box 
that appears when you click the Add button. Click the OK push 
button of the dialog box when you have selected the item(s) you want 
(if you want to clear the item list of the object selection list window 
before addition then click the OK (with clear) push button). 

By means of the Del push button you delete the selected item from 
the list. 

By means of the Save push button you save the object list to a disk 
file (name extension must be .QDO). 

By means of the Open push button you read a previosly saved object 
list from a disk file. 

 

You can move back from the selection list window to the main 
window, and the selection list window will remain visible on the 
screen. By means of the Done push button you remove the selection 
list window. 

Object Selection 
List 
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After you have clicked a Value push button, a dialog box will be 
displayed on the screen. 

 

Figure 4 - 7. Defining a Value push button. 

This box contains the following information (either default values or 
values selected earlier): 

− the value to be monitored. This is a signal (or a parameter). 

− a reference value. This can be a constant value (e.g. zero) or a 
signal (or a parameter). 

− the display format (a signed integer, an unsigned integer or a 
hexadecimal number) 

Value Push 
Buttons 
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When the above mentioned selections have been made, click the OK 
push button. Next to the Value push button clicked there will appear 
the actual value, in the selected format or the difference between the 
value to be monitored and the reference value. 

If the value to be monitored is a signal (or a parameter) and the 
reference value is zero, the identifier of the signal (or a parameter) 
will be displayed on the top of the Value push button (instead of the 
Value n text). 

The parameter (or signal) to be changed is first selected with the 
Object push button (or with the Object Selection List). 

Next click the ObjVal push button, which brings up on the screen a 
dialog box with a selection list for the display format and a data entry 
field for entering the new value. 

 

Figure 4 - 8. Value change. 

If you wish to change the display format, select a new format from the 
list of formats (a signed integer, an unsigned integer, a hexadecimal 
number or a binary number). 

If you wish to change the value, write the new value in the data entry 
field. 

Finally, click the OK push button (or press the Enter key). 

NOTE: If you wish to change only the display format, leave the data 
entry field blank! 

Changing Values 
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If you have selected the Redisp check box then DDCTool redisplays 
the dialog box so that you can change the value of the same object 
again. Click the Cancel push button (or press the Esc key) when you 
want remove the dialog box from the screen. 

You can restore the previous value back if you press the F12 function 
key (or click the Undo push button of the dialog box if the box is 
visible) as the first operation after value change.
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Chapter 5 - File 

 

Figure 5 - 1. Pull-down menu for File. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

By means of the command Open Configuration in the File menu you 
can restore previously saved measurement configuration definitions. 

Open 
Configuration 
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By means of Open Graph in the File menu you can restore any 
previously saved graph file. When you have selected the file you want 
to restore then a dialog box will be displayed on the screen. 

 

Figure 5 - 2. Open graph dialog box. 

With this dialog box you can restore the graph source and/or scaling 
definitions and/or the graph curves. Graph curves can be copied to 
normal curves or reference curves. You can make a copy to 
reference curves only if the current X- and Y-axis values are the 
same as they were when the graph curves to be copied were saved 
(use of reference curves, see Chapter Other / Show/Hide Ref Graph). 

 

When you select this command all measurement configuration 
definitions of the DDCTool (Object push button, Value push buttons, 
Step push buttons etc.) are saved for later use to the file 
CONFIG.QDC in the DDCTOOL directory. If the file CONFIG.QDC 
already exists then its old content is overwritten. 

Open Graph 

Save Configuration 
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When you select this command a dialog box will be displayed on the 
screen. By this box you define a file (extension must be .QDC) and all 
measurement configuration definitions (Object push button, Value 
push buttons, Step push buttons etc.) are saved to this file for later 
use. 

 

You can save the current graphical display information to a disk file 
for later use. When you select this command a dialog box will be 
displayed on the screen. 

 

Figure 5 - 3. Save graph dialog box. 

With this dialog box you select the graph bitmap file mode, graph line 
width type and the desired file directory, write the base part of the file 
name (e.g. MEAS23) and write the Comment line (e.g. customer 
name, application etc.). 

If the saved graph will be printed in a black-and-white format then it is 
usually better to use dissimilar line widths. 

If a saved graph will be shown by an overhead projector then double 
line widths shoud be used. 

 

When you click the OK push button two or three disk files will be 
created: 

Save Configuration 
As 

Save Graph As 
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− binary file (extension .QDG, e.g. MEAS23.QDG). The content of 
this file is: graph type (actual values or data logger samples), 
comment text, source definitions, graph scaling definitions and 
actual graph curves. 

− text file (extension .TXT, e.g. MEAS23.TXT). The content of this 
file is: graph type (actual values or data logger samples), 
comment text, date and time, source definitions and graph 
scaling definitions. 

− bitmap file (extension .BMP, e.g. MEAS23.BMP). This file is not 
created if you selected the No Graph Bitmap File mode from the 
Graph Bitmap File Mode list. The content of this file is: comment 
text, date and time, source definitions, graph scaling definitions 
and actual graph curves. 
Source and graph scaling definitions are missing if you selected 
the Graph Bitmap File w/o Definitions mode from the Graph 
Bitmap File Mode list (in this mode the bitmap file is smaller and 
you can use this alternative if you have not much free disk space 
left). 
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Figure 5 - 4. Graph display bitmap file (.BMP) example. 

The above-mentioned files are used as follows: 

− binary (.QDG) file: By means of the command Open Graph in 
the File menu you can restore the definitions and graph curves 
of this file. 

− text (.TXT) file: When you are creating a document (e.g. with the 
WinWord program) you can insert the content of this file into the 
document. 

− bitmap (.BMP) file: When you are creating a document (e.g. with 
the WinWord program) you can insert the content of this file into 
the document. 
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If you wish to save the whole current screen with its graphics curves 
for later use, first press the PrintScreen key on your keyboard. This 
will copy the entire content of the window to the clipboard. In error 
situations Save PrintScreen Image As is an easy way to save error 
messages in case they are needed later. 

Next select the command Save PrintScreen Image As from the File 
menu. The Clipboard window will be displayed on the screen. Select 
the command Save As from this window's File menu and execute the 
save to the desired disk file in the directory you want to use. Finally, 
close the Clipboard window by selecting File-Exit. 

When you wish to use a saved image at a later time, for example, in a 
document that is created with the WinWord program, you must first 
read the image file back to the clipboard with the Clipboard program 
that is started, say, from the Program Manager's Clipboard icon and 
then move the picture to WinWord or first edit it e.g. in Paintbrush. 

When an image is read to the clipboard, you can use the Paintbrush 
program to remove from it, say, the part above the graph display 
area. This should be done before pasting the image into a document 
that is being created. Follow the steps below: 

− if the Paintbrush is not running, start it, enlarge its window to the 
maximum size and remove the Tools and Palette help windows 
from the main window by means of the View menu. If the 
Paintbrush has already been started earlier, select File-New. 

− copy the image that has been read to the Paintbrush window by 
selecting View-Zoom Out, Edit-Paste (twice!) and View-Zoom 
In. 

− clip the desired image area with the mouse (press the mouse's 
left-hand button down at some corner of the desired image area 
and with the button still held down, drag the clipped area to the 
desired size. Then release the mouse button) 

Save PrintScreen 
Image As 
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− finally, copy the clipped area to the clipboard (in place of the 
before read image) by selecting Edit-Copy 

− move from the Paintbrush program back to the word processing 
program and paste (Edit-Paste) the area clipped above into the 
desired place in the document that is being created. 

If you have a printer connected to your PC then the current graphical 
display can be printed with source and scaling definitions by means of 
the command Print Graph in the File menu. 

 

 

Figure 5 - 5. Print graph. 

 

The printer settings can be changed by the Windows Control Panel 
(Printers). 

 

An About DDCTool box will appear. The DDCTool version and the 
DDC type are shown there. 

 

See Chapter Exit. 

 

 

 

Print Graph  

About DDCTool 

Exit 
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Chapter 6 - ActValues 

 

Figure 6 - 1. Pull-down menu for ActValues. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

The width of the display area is 500 pixels and it is divided into 10 
parts by broken lines. If the updating interval of the actual values to 
be monitored is e.g. 3 ms (the fastest possible), then the width of the 
entire area corresponds to a time of 1.5 seconds (500 * 3 ms). 

Graph Display 
(Single DDC) 
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The actual values to be monitored are first selected by means of the 
Value1, Value2, Value3 and Value4 push buttons (and possibly also 
with the Object push button) in the manner described in the Chapters 
Using the DDCTool / Object Push Button and Using the DDCTool / 
Value Push Buttons. 

Next you select the Graph Display (Single DDC) command from the 
ActValues menu. The actual values to be monitored graphically are 
selected from the curve list to be displayed on the screen. 

 

Figure 6 - 2. Graph display selection (single DDC). 

A curve can display either an analog value or a bit value. If you want 
to display an analog value then you can define the scalings and 
offsets to be used in the display (the computational formula is 
presented above the list). 

If you want to display a bit value then you must define the bit to be 
displayed as follows: 

 value_number(1...5):bit_number(0...15) 

The scaling and offsets of the bit display are fixed. 
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Finally, you can define the display interval as a multiple of the DDC 
communication rate (see Appendix 1, parameter M). The Graph 
Sample Interval thus expresses whether each actual value 
transmitted by the DDC is to be displayed (in which case the curve 
has maximum precision but covers a short time span) or whether the 
actual values transmitted by the DDC are to be sampled only at 
certain intervals (in which case the curve is less precise but covers a 
longer time span). 

The descriptions of the actual values to be monitored can be 
displayed on the screen by using the Descriptions push button. 

When you have done all the definitions you click the OK push button 
to start the real-time graphical display (at the left side of the push 
buttons, corresponding to the analog values selected, there will be a 
# sign). During display, the display interval, the scaling and the 
number of curves to be displayed can be changed by means of the 
command Graph Display (Single DDC) in the ActValues menu. 

The display can be stopped by using the F4 function key (or by 
selecting the command Stop/Restart Graph Display in the 
ActValues menu). The short horizontal broken colour lines at the 
right-hand edge of the graph display show the values of Y-offset Bs 
(analog graphs) or 0-levels (bit graphs). 

You can continue the display operation by pressing the F4 function 
key again. 

You can copy the current graph curves to the reference curve 
memory by means of the command Copy Curr Graph to Ref in the 
Other menu (see Chapter Other / Copy Curr Graph to Ref). 

 

If you click the OK (autoscal) push button then all selected analog 
graphs are autoscaled. 

If you clear the Y-offset A, Y-scale and Y-offset B fields in one or 
more analog graph definitions and then click the "normal" OK push 
button then the graphs with the empty scaling fields are autoscaled. 

Automatic 
Scaling 
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The display can be stopped by using the F4 function key (or by 
selecting the command Stop/Restart Graph Display in the 
ActValues menu). 

You can continue the display operation by pressing the F4 function 
key again. 

 

See Chapter Using the DDCTool / Value Push Buttons. 

If you define Value4 = signal 101-04 (MAIN_STATUS_WORD) or 
signal 101-05 (AUX_STATUS_WORD) then the status information 
from the DDC is shown on the right side of the screen (see Chapter 
Using the DDCTool / Status Panel). 

 

See Chapter Using the DDCTool / Object Push Button. 

 

See Chapter Using the DDCTool / Changing Values. 

 

See Chapter Using the DDCTool / Changing Values. 

 

The current definitions of the Value and Object push buttons can be 
displayed on the screen by using the F9 function key (or by selecting 
the command Show Descriptions in the ActValues menu). 

If the graph display or value recording is on then the F9 function key 
displays the definitions of the selected graph or record items. 

If the text "Description not found" is shown it means that you have 
never selected this DDC as a target DDC after the startup of 
DDCTool. 

Stop/Restart Graph 
Display 

Define Value 1 ... 4 

Define Object 

Set Object Value 

Undo Object Value 

Show Descriptions 
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For the purpose of measuring step responses, you can define two 
step push buttons (Step A and Step B) by means of the commands 
Define Step A and Define Step B in the ActValues menu. 

 

Figure 6 - 5. Definition of step A. 

 

 

Figure 6 - 6. Definition of step B. 

Define Step A and 
Step B 
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The step push buttons are visible only after the definition has been 
made. The Step A push button is generally used for making the 
actual step (positive or negative), whereas the Step B push button is 
used to restore the changed value back to its initial state so that a 
new step can be made. 

Before making a step, you must start the graphical monitoring of the 
desired actual values. If you check the box Restart Graph Display in 
the Define Step B dialog box then the monitoring starts automatically 
every time when you click the Step B push button. 

When a step has been made, the graphical display can be stopped 
manually by means of the F4 function key. If you set the value of the 
optional Sample Count After Step field in the Define Step A dialog 
box then the graphical display stops automatically at the desired point 
(in this case you must define Value1 so that the value to be 
monitored is the same as the step signal and the reference value is 
zero). 

If you check the box Show Ref Graph After Step Stop in the Define 
Step A dialog box then the reference curves (if you have defined 
them) are automatically shown on the screen after the graphical 
display has stopped (you cannot use this check box if the Sample 
Count After Step field is empty). 

 

You can remove a previously defined Step button from the screen by 
clearing the Step Signal field in the step definition dialog box of the 
Step button before clicking the OK button of the dialog box. 
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The actual values to be recorded are first defined by means of the 
Value1, Value2, Value3 and Value4 push buttons. 

Next you select the Start Value Recorder command from the 
ActValues menu. 

This brings up on the screen a dialog box by means of which you can 
carry out the following definitions: 

− identifiers of the actual values to be recorded. A new identifier is 
added to the identifier list by means of the Add push buttons 
and the identifier selected from the list is removed by means of 
the Remove push button. 

− number of sample batches that can be in the file (Recorder 
Size). The max size depends on the size of your free disk space. 

− record (sample) interval (multiple of 3 ms) 

− filename (extension is .TXT) and directory 

The descriptions of the actual values to be recorded can be displayed 
on the screen by using the Descriptions push button. 

Recording starts when you click the OK push button. 
By pressing the F9 function key you can see the definitions of the 
selected record items. 

If the record interval time is not long enough during the recording then 
an error message SAMPLE INTERVAL (n/m ms) TOO SHORT is 
displayed on the STATE line (if this happens too often then the 
recording is automatically stopped). If this error message is displayed 
seldomly then the reason may be an error in the communication 
between the PC and the DDC. 

With one DDC and the value of the startup parameter M is 1 (see 
Appendix 1) the actual values of Value1...4 are displayed at the right 
sides of the Value buttons during the record. 
 

The recording format is the same as in the Excel program (sample 
value lines are separated by NewLine characters and sample values 
in a sample value line are separated by Tab characters). The last 
sample value line is always at the end of the file. When the record file 
becomes full, then the oldest sample value line will be removed in 
order to make room for the new sample value line. 

Start Value 
Recorder 
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The recording can be stopped by pressing the F8 function key (or by 
selecting the Stop Recorder command from the ActValues menu). 

 

Stop Recorder 
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Chapter 7 - Params 

 

Figure 7 - 1. Pull-down menu for Params. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

Use of the command Parameters (Immediate Update) in the 
Params menu brings up on the screen a dialog box (if graphical 
monitoring of the actual values is running, it must first be stopped by 
pressing the F4 function key). 

 

Figure 7 - 2. Parameter dialog box. The text ON-LINE indicates that 
all value changes you make are immediately transmitted to the DDC. 

Processing the 
Parameters 
(Immediate update) 
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The parameter list of the dialog box has the following columns: 

ID Identification number of the parameter 

Description Description text of the parameter 

Actual Actual value (you can change this) 

Min Minimum value 

Max Maximum value 

Init Default value 

Type Data type: 
I2 = 16 bit signed integer 
PB = packed Boolean value (16 bits) 
U2 = 16 bit unsigned integer 

* Actual value has been changed after upload 
or after file open 

You can select a parameter from the parameter list by means of the 
Up and Down arrow keys and/or the mouse. By means of the New 
value data entry field and the OK push button (or the Enter key) you 
can change the value of the selected parameter (an asterisk will be 
displayed after changed parameters). This change is immediately 
transmitted to the DDC. You can restore the previous value back if 
you click the Undo push button (or press the F12 function key) as the 
first operation after value change. 

Sequential changes: You can change values of sequential 
parameters in the ascending order as follows: 

− select the first parameter you want to change 

− press the Caps Lock key down and hold it down 

− write the new value of the selected parameter and press the 
Enter key. Now the value of the selected parameter changes 
and the selection moves automatically to the next parameter. 

− continue by writing the new value of the selected parameter and 
pressing the Enter key untill all changes have been made 
(you can skip parameters that you do not want to change by 
pressing the Enter key wihout writing the new value). 

− release the Caps Lock key 
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By means of the File Open push button you can read a parameter file 
that has previously been saved (see below) and display the 
parameters in the parameter list of the dialog box. 

By means of the Upload push button you can upload all the DDC 
parameters and display them in the parameter list of the dialog box. 

By means of the File Save push button you can save the parameter 
list of the dialog box to a disk file (extension must be .QDP). On the 
Comment line you can write, for example, the customer's name, the 
application, etc. 

By means of the Download push button you can set all the DDC 
parameters to the values specified in the parameter list of the dialog 
box. 

By means of the Compare push button you can compare the current 
parameter list of the dialog box with another parameter list (saved by 
the File Save push button). 

By means of the Version Update push button you can convert an old 
parameter list file into a new format when the parameter version 
number in the DDC firmware has changed. The procedure is as 
follows: 

− Upload parameters (click the Upload push button) from the new 
firmware or open a parameter list file (File Open) that you have 
uploaded from the new firmware. 

− Click the Version Update push button and select a parameter 
list file that you have uploaded from the old firmware. After your 
selection the DDCTool scans the new parameter list on the 
screen and if it finds a parameter that is in the selected old file 
then the DDCTool copies the actual value of that parameter from 
the disk file to the the screen list. An asterisk (*) is displayed 
after every modified parameter on the screen. 

− When all parameters have been processed the DDCTool 
displays a list of all modified parameters. This list can be printed 
or saved to disk. 

− Now you can download and/or save the updated parameter list 
(check the correctness of the list before you do this!) 

It is also possible to convert a new parameter list file into an old 
format (simply change the words "new" and "old" in the previous 
procedure). 
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By means of the Print push button you can print the current 
parameter list (if you have a printer connected to your PC). 

 

Use of the command Parameters (No Immediate Update) in the 
Params menu brings up on the screen a dialog box by means of 
which you can execute the same operations as in the previous 
chapter. The only difference is that now a change made in the 
parameter list (by the New Value data entry field and the OK push 
button) is not transmitted to the DDC. 

 

Processing the 
Parameters (No 
immediate update) 
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Chapter 8 - Diagrams 

 

Figure 8 - 1. Pull-down menu for Diagrams. Note that the menu 
command may be inactive if it is not possible to use it in the current 
situation. 

 

A diagram is usually a schematic representation of the target DDC 
software but in general diagrams can contain any graphical line and 
text information. Diagrams are stored on the disk as diagram files 
(filename extension is .QDD). 

Use of the command Diagrams in the Diagrams menu brings up on 
the screen a Diagram window with menu commands of its own 
(if graphical monitoring of the actual values is running, it must first be 
stopped by pressing the F4 function key): 

 

Figure 8-2. Diagram window. 

 

Diagrams 
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By means of the Open Diagrams command in the File menu of the 
Diagram window you read a diagram file. 

One diagram file includes usually several separate diagram sheets 
and you can select the diagram sheet you want to see on the screen 
by the commands in the Other menu of the Diagram window (or by 
pressing the CTRL key and either the right or the left arrow key). 

 

 

Figure 8-3. A schematic diagram in the Diagram window. 

Diagram Window 
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Mouse functions in the Diagram window work as follows: 

− if you press the CTRL key and click on a line that is connected 
to a parameter/signal then the actual value of this 
parameter/signal is shown on the screen in real time. 
If you do this when the cursor is not on a parameter/signal line 
(or there are no such lines at all in the diagram) then you can 
define any parameter/signal you want to monitor in the click 
position. 
If you press the F10 function key then you can see in the 
diagram the indeces of the parameters/signals you have defined 
(press F10 again to restore the normal display state). 
By means of the Save Diagrams As command in the File menu 
of the Diagram window you can save the current diagram file 
with the display definitions you have made. 

− if you click on a previously defined actual value display (see 
above) then you see the information box of this parameter/signal 
and you can change its value (or display format) ON-LINE. 
If you click somewhere else on the screen (or press the F11 
function key) then the diagram is minimized so that it is totally 
visible. If you click anywhere on a minimized diagram then the 
diagram is restored to its normal size and the click position is in 
the center of the screen. 

− If you press the SHIFT key and click on a previously defined 
actual value display then this display disappears from the 
screen. 

 

 

By clicking on the Done! menu command of the Diagram window you 
can hide this window. 
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Chapter 9 - DataLogger 

 

Figure 9 - 1. Pull-down menu for DataLogger. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

The data logger resides in the DDC. You can control its operation and 
upload its contents by the DDCTool program. 

Data logger has six logging channels. The maximum number of 
sample values in one channel is 1000. 

 

Command Copy Value Definitions to Ch 1...4 in the DataLogger 
menu copies the signal and scaling definitions of Values 1...4 to data 
logger channels 1...4 (see Chapter Using the DDCTool / Value Push 
Buttons and Chapter ActValues / Graph Display (Single DDC)). 

Use of the Data 
Logger 

Copy Value 
Definitions to  
Ch 1 ... 4 
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A data logger channel is defined by means of a command Define 
Channel 1 ... Define Channel 6 in the DataLogger menu. 

 

Figure 9 - 2. Definition of a data logger channel. 

 

Command Common Definitions in the DataLogger menu is used to 
set the data logger's common definitions: triggering condition, 
triggering condition's reference value, number of samples to be 
collected after triggering and sampling interval. 

 

Figure 9 - 3. Common definitions of the data logger. 

With the Codes button you can select the trig condition code. 

Define Channel  
1 ... 6 

Common 
Definitions 
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The data logger is controlled by means of the command Control in 
the DataLogger menu. A dialog box will appear which displays the 
data logger's status and the push buttons corresponding to possible 
control functions in the given situation. 

 

Figure 9 - 4. Control dialog box when the data logger is logging. 

 

 

Figure 9 - 5. Control dialog box when the data logger is not logging. 

Click the push button corresponding to the desired function (or the 
Cancel push button if you only want to find out the data logger's 
status and you do not wish to carry out any control action). 

Control 
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When the logging has stopped, the sample values logged to the data 
logger channels are uploaded from the DDC by means of the 
command Upload in the DataLogger menu (if graphical monitoring of 
the actual values is in progress, it must first be stopped with the F4 
function key). 

 

Figure 9 - 6. Upload of the data logger sample values. 

The sample values to be displayed graphically are selected from a list 
that is displayed on the screen. When the selection is made, you 
must define the scalings and offsets to be used in the display (the 
computational formula is presented above the list). 

Finally, click the OK push button, whereupon the program uploads 
the logged values from the DDC and displays them graphically (since 
there are only 500 pixels in the display area and there are 1000 
sample values, the average value of two adjacent sample values is 
displayed in one pixel). 

The time scale is displayed below the X axis in such a way that the 0 
point is at the triggering point (or at the right-hand edge if no 
triggering has taken place). The short horizontal broken colour lines 
at the right-hand edge of the graph display show the values of 
Y-offset Bs. 

 

If you click the OK (autoscal) push button then all selected channels 
are autoscaled. 

If you clear the Y-offset A, Y-scale and Y-offset B fields in one or 
more channels and then click the "normal" OK push button then the 
channels with the empty scaling fields are autoscaled. 

Upload 

Automatic 
Scaling 
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By means of the command Graph Display of Uploaded Samples in 
the DataLogger menu the scaling and offset values of the uploaded 
samples can be changed if needed. 

You can copy the current graph curves of the uploaded data logger 
sample values to the reference curve memory by means of the 
command Copy Curr Graph to Ref in the Other menu (see Chapter 
Other / Copy Curr Graph to Ref). 

 

The sample value curves can be expanded horizontally by clicking in 
the graph area at the X-point you want to expand (during the 
expansion, the expansion point remains where it is on the screen). 
With each click the curves expand to double their previous size until 
they have expanded 64-fold compared with their initial size (with each 
click the expansion point can be located in a different place). If a 
mouse is not in use, the same function can be performed by means of 
the Expand Graph Display command in the DataLogger menu. 

An expanded display can be restored to normal size by clicking the 
mouse's right-hand button anywhere in the graph area. If a mouse is 
not available, the same function can be performed by means of the 
Expand Graph Display command in the DataLogger menu. 

NOTE: When the expansion is in effect then the graph shown is 
based on actual sample values (instead of the average value of two 
adjacent sample values). 

Graph Display of 
Uploaded Samples 

Expand Graph 
Display 
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The uploaded sample values can also be displayed in numerical form 
by means of the command Numeric Display of Uploaded Samples 
in the DataLogger menu. 

 

Figure 9 - 7. Numeric display of the uploaded data logger samples. 

By means of the Print push button you can print the sample values (if 
you have a printer connected to your PC). 

By means of the FileSave push button you can save the sample 
values to a disk file (extension is .TXT). The save format is the same 
as in the Excel program (sample value lines are separated by 
NewLine characters and sample values in a sample value line are 
separated by Tab characters). 

You quit the displaying of the numeric values by clicking the Done 
push button. 

Numeric Display of 
Uploaded Samples 
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Command Monitoring in the DataLogger menu (available only with 
ACV 700 version 60M or later) brings up on the screen a dialog box. 

 

Figure 9 - 8. Start of the data logger monitoring operation (ACV 700 
only). 

Now you can select the number of the first sample file batch (1...99) 
and the name and directory of the log file (all sample files will be 
written to this directory, too). 

When you click the Start push button then DDCTool continously polls 
data logger statuses of connected DDC. 

 
WARNING! If there are one DDC connected to the DDCTool then this 
polling may increase processor load of this DDC too much. Load increase in 
a DDC is (approx.) = 10 / 1  %. 

 

After start the text on the Cancel push button is changed to Stop. 

On the STATE line the current monitoring status information is 
displayed. 

Monitoring  
(ACV 700 only) 
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If a data logger of the DDC has been trigged then DDCTool: 

− upload data logger samples from DDC to disk files. The name 
format of a sample file is: 
 
  DLSbb250.TXT 
 
where bb is the batch number 01...99. The save format of 
samples is the same as in the Excel program (sample value 
lines are separated by NewLine characters and sample values in 
a sample value line are separated by Tab characters). 
 
If a sample file batch with this batch number already exists on 
the disk then the sample files of this batch are overwritten. 
 
If the disk becomes full then the sample files of the oldest file 
batch are removed from the disk before the new sample files are 
written. 

− writes log information (ID of the DDC that has been trigged, 
date, time and batch number) to the log list on the screen and to 
the user-specified log file. 

− increments the batch number (after number 99 comes number 
1). 

− waits untill the triggering condition is off in the DDC that has 
been trigged at the beginning of this sequence (no wait if the 
condition is now on but it has been in the off state for a while 
after the beginning of this sequence). 

− clears and restarts data loggers of DDC. 

− restarts the polling of data logger status of DDC. 

 

This monitoring mode is on until you stop it by means of the Stop 
push button. 
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Chapter 10 - Control 

 

Figure 10 - 1. Pull-down menu for Control. Note that the menu 
command may be inactive if it is not possible to use it in the current 
situation. 

 

Select the command Local/Remote Control from the Control menu. 
The control window appears on the screen. 

You can move back from the control window to the main window, and 
the control window will remain visible on the screen. If you wish to 
hide the control window, click the Done push button. 

 

 

Figure 10 - 2. Local control (push buttons 1 and 0 are only with DC 
drives). 

By means of the Loc/Rem push button you switch from local control 
to remote control. 

By means of the 1 push button you switch the main controller ON (DC 
drives only). 

By means of the 0 push button you switch the main controller OFF 
(DC drives only). 

By means of the Start push button you start the DDC. 

By means of the Stop push button you bring the DDC down as it is 
programmed. 

By means of the CoastStop push button you stop the DDC 
immediately (stops modulation in AC; blocks firing pulses in DC). 

By means of the Reset push button you reset DDC faults. 

Local/Remote 
Control 

Local Control 
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By means of the RefVal push button you set the DDC's speed 
reference value. 

By means of the SpeedReference scroll bar you change the DDC's 
speed reference value. The speed reference is changed by pressing 
the control's left or right-hand button. The speed of change increases 
the longer the button is held down. 
The change increment size of the speed reference can be set by 
means of the RefCoeff push button (the initial increment size is 100). 
It is also possible to change the speed reference value by dragging 
the thumb with the mouse. 

 
WARNING! If the DDCTool is stopped while in the local mode, the 
drive will be without any control. 

If an ACV 700 drive is stopped in local mode the drive does not notice 
it but continues to do what it was doing. 

 

 

 

Figure 10 - 3. Remote control. 

By means of the Loc/Rem push button you switch from remote 
control to local control.  

Remote Control 
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Chapter 11 - Faults 

 

Figure 11 - 1. Pull-down menu for Faults. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

By means of the command Read Last Fault/Alarm Codes in the 
Faults menu, you can read the fault/alarm code corresponding to the 
last fault/alarm situation that has occurred in the DDC (if the 
fault/alarm has already disappeared a copy of the fault/alarm code is 
stored in the DDC). The read operation removes the fault/alarm 
code's copy if the fault/alarm situation has already disappeared. 

 

Figure 11 - 2. Latest fault and alarm codes. 

Reading the Last 
DDC Fault/alarm 
Code 
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If the graphic monitoring of the actual values is running, it must first 
be stopped with the F4 function key before you can do the upload. By 
means of the command Upload Fault Logger in the Faults menu, 
you can read the content of the DDC's fault logger (a maximum of the 
100 latest faults, alarms or events). When the entire content has been 
read, above the fault list will appear the DDC's date and the clock 
time at the instant of the last fault uploaded. In the Fault Logger the 
date, time of the fault, the fault code and the description of it are in 
the faults list; latest fault on top. 

 

Figure 11 - 3. Fault Logger shows last 100 faults, alarms or events. 

If the time of DDC has not been set (see Chapter Other / Set DDC 
Time) or the APC board has not been connected to the DDC, times 
and dates in the Fault Logger can be invalid. 

The codes can be found in 
ACV 700: Firmware 1.0 (code 58054399), 
ACV 700: Service Instruction (code 58054499), 
DCV 700: Software Description 1.0 (code 61101446) and 
DCF 500/700 manuals. 
Example: Codes under 99 are faults, code 99 is a reset and codes 
over 100 are alarms. Some of the codes are events e.g. 110 is a 
system restart. The outgoing alarm code has a minus (-) sign in front 
of it. 

By means of the Print push button you can print the content of the 
fault logger (if you have a printer connected to your PC). 

Uploading/clearing 
the Fault Logger 
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By means of the FileSave push button you can save the content of 
the fault logger to a disk file. 

By means of the Clear push button you can clear the content of the 
fault logger. 

After you wish to leave the fault logger dialog box click the Done push 
button 
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Chapter 12 - Other 

 

Figure 12 - 1. Pull-down menu for Other. Note that some menu 
commands may be inactive if it is not possible to use them in the 
current situation. 

 

The DDC communication link can be restarted following a break in 
the link by means of the command Restart Communication in the 
Other menu. 

 

By means of the command Read Comm Statistics in the Other 
menu you can see the number of communication errors. 

 

You can, if needed, remove the stopped graphical display from the 
screen with the F5 function key (or by selecting the command Clear 
Graph Area in the Other menu). 

 

The height of the graphical display area is 300 pixels, and it is divided 
into six parts by broken lines. By means of the Set Y-axis Zero to... 

Restart 
Communication 
with the DDC 

Read the DDC 
Communication 
Statistics 

Clear Graph Area 

Set Y-axis Zero to... 
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commands in the Other menu the zero point on the Y axis can be set 
to the top of the area, to the middle, or to the bottom. By scaling the 
display curves can be placed inside the area in the Y direction. You 
can use these commands only if the graph area is empty. 

 

You can copy the current (stopped) graph curves (actual values or 
data logger samples) to the reference curve memory by means of the 
Copy Curr Graph to Ref command in the Other menu (in addition to 
this you can copy the graph curves from a saved disk file to the 
reference curve memory, see Chapter File / Open Graph). Each copy 
replaces the previously copied reference curves. 

 

You can show (or hide) the reference curves on the screen with the 
F6 function key (or by means of the Show/Hide Ref Graph command 
in the Other menu). The display of the reference curves is impossible 
if the current X- and Y-axis values are not the same as they were 
when the graph curves were copied to the reference curve memory. 

 

If normal curves hide the reference curves, then you can temporarily 
raise the reference curves higher with the F7 function key (or by 
means of the Ref Graph Shift command in the Other menu). 

Copy Curr Graph 
to Ref 

Show/Hide Ref 
Graph 

Ref Graph Shift 



Chapter 12 - Other 

DDCTool 4.x 12 - 3 

 

The window calculator is started by means of the command Window 
Calculator in the Other menu. 

 

Figure 12 - 3. Window calculator. 

The calculator allows you to carry out addition, subtraction, 
multiplication and division with signed integers, unsigned integers and 
hex numbers. You can also use the calculator to carry out 
conversions between the different forms of numbers.  

When you no longer need to use the calculator, click the Done push 
button. 

 

The command Set DDC Time in the Other menu copies the date and 
time of the PC to the date and time of the DDC. 

NOTE: If an APC is connected to the DDC, it will send date and time 
every two seconds to the DDC and this overrides the date and time 
sent by DDCTool. 

Window Calculator 

Set DDC Time 
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By means of the command Lock Value Changes in the Other menu 
you can prevent all changes of DDC values by the DDCTool program. 

 

Figure 12 - 4. Lock operations. 

When the dialog box appears, write the current password. 

If you want to lock/unlock then click the OK push button (or press the 
Enter key). 

If you want to change your password then select Change password, 
write your new password and click the OK push button. Password 
length must be 4...8 characters, passwords are case-insensitive. 

Remember your new password because you cannot lock/unlock 
without it! 

The default password after the installation of the DDCTool program is 
DDCTOOL. You must change this before you can use the lock. 

Lock Value 
Changes 
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Use of the command I/O Test in the Other menu brings up on the 
screen a dialog box where the values of the analog and digital inputs 
and outputs of the DDC are displayed (if the graphic monitoring of the 
actual values is running, it must first be stopped with the F4 function 
key). 

 

Figure 12 - 5. I/O test dialog box (ACV 700 only). 

By means of the Normal/Test push button you can start the test 
mode. In this mode you can change state of the analog and digital 
outputs by the controls in the dialog box. By clicking the Normal/Test 
button again you return to the normal mode. 

By means of the Scaling push button you can set the maximum and 
minimum values used in the scaling of the analog channels. 

Finally, click the Done push button.

I/O Test (ACV 700 
only) 
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Chapter 13 - Exit 

 

Figure 13 - 1. Pull-down menu for Exit. 

 

The Exit command in the Exit menu is used to stop the program. If 
desired, the current configuration settings of the DDCTool can be 
copied into a CONFIG.QDC file in the DDCTOOL directory. 

 

Figure 13 - 2. You can save the current configuration when you exit. 

You can stop and restart the DDCTool program (and PC) without 
stopping the DDC when the DDC is running in the remote control 
mode. 

 

 
WARNING! If the DDCTool is stopped while in the local mode, the 
drive will be without any control. 

If an ACV 700 drive is stopped in local mode the drive does not notice 
it but continues to do what it was doing. 

 

Exit 
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If the DDC is in local mode, DDCTool wants to know if it is really your 
intention to exit the program because the DDC(s) then has no control. 

 

Figure 13 - 3. If you exit the DDCTool while in the local mode the 
DDC has no control. 
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Chapter 14 - Appendix 1 

By startup parameters you can customize your copy of the DDCTool 
program. Startup parameters are used in the Target line of Properties 
of DDCTool 4.x shortcut. 

Set or change values of startup parameters as follows: 

− stop DDCTool (if it is running) and click (only once!) the 
DDCTool 4.x shortcut with the right mouse button. 

− select Properties in the File menu of the Program Manager 

− add the required startup parameters to the end of Target line as 
follows : 
 
  <path>\DDCTOOL.EXE /Xnnn /Ymmm ... 
 
where X and Y are identifier letters of the startup parameters 
(see below) and nnn and mmm are the values to be assigned to 
these parameters. 

− click the Apply and OK push button 

− start DDCTool (double click the DDCTool 4.x shortcut) 

Startup Parameters 
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PARAM           MEANING AND VALUES 

 

    M The message transmit interval (in 3 ms multiples) of the 
values transmitted by the DDC. 

The permissible values are 1...250. 

The default is 1 (= 3 ms). 

If the parameter/signal upload in your computer does 
not work (e.g. PC OVERLOAD error or PC halts) with 
the default value of this startup parameter (and you 
cannot use the Standard mode of Windows) then you 
must increase the value of M until the parameter/signal 
upload works without errors. 
NOTE: If your PC includes a Power Management 
feature then turn it off and restart the program (without 
changing the M parameter). 

Example: /M2 

 

PARAM           MEANING AND VALUES 

 

    C The length of the optical cable with the SNAT624. 

The default is 10 metres (or shorter). 

If the cable is longer than 10 metres then you must use 
this startup parameter followed by the length of cable (in 
metres). 

Examples: 

/C1 (up to /C10) low optical power (default value) 

/C11 (up to /C20) medium optical power 

/C21 (and larger) high optical power 

The lengths are in metres. 
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PARAM           MEANING AND VALUES 

 

    F Upload mode of parameters, signals and faults (ACV 
700 only). 

The permissible values are 0 (fast) and 1 (slow). 

The default is 0. 

The value of this parameter must be 1 if the version of 
your ACV 700 is older than 60A. 

Example: /F1 
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Chapter 15 - Appendix 2 

If you make a mistake when you use the DDCTool then the program 
displays an error message box. These error messages are self-
explanatory. 

 

On the STATE line of the main window there can be one of the 
following error messages: 

− SAMPLE INTERVAL (n/m ms) IS TOO SHORT. 
You specified a shorter sample interval than it is possible to use 
because of communication timing limitations 
(see Chapter ActValues / Start Value Recorder). 
Value n is the shortest possible sample interval and value m is 
the interval you specified. 

 

− PC OVERLOAD (text). 
Your PC is so slow (or some other simultaneously running 
program causes a high processor load) that it cannot receive all 
the messages the DDC is transmitting. 
NOTE: If your PC includes a Power Management feature then 
turn it off and restart the program. 
If graphical monitoring or file recording of actual values was 
running then you must increase the sample interval (this error 
stops the monitoring). 
Otherwise, you must stop the DDCTool program and increase the 
value of startup parameter M before restarting the program (see 
Appendix 1). 

 

− DDC CONNECTION IS BROKEN. 
Communication between the DDCTool and DDC(s) is broken. The 
same text is shown in a dialog box, which has to be 
acknowledged before going on. 

Error Messages 



Chapter 15 - Other 

DDCTool 4.x 15 - 2 



 

DDCTool 4.x 16 - 1 

Chapter 16 - Appendix 3 

In addition to the actual values of a DDC, it is also possible to monitor 
numerically and graphically (min sample rate is 3 ms) values of the 
output pins of APC function blocks as follows: 

− add a DRTRA function block to the APC application program 
and connect the output pins to be monitored (max. 8) to the IN 
input pins of this block. The execution cycle time of the DRTRA 
block will be the sample rate of the actual values (min 3 ms). Set 
values 12108...12115 to the IND input pins of the DRTRA  block. 
The value of call parameter C1 must be 1 and the value of call 
parameter C2 is the number of the output pins to be monitored 
(1...8). 

− when the APC application program is executing, define the 
desired Value push buttons of the DDCTool so that the data 
location of a button is one of the signals 12108...12115. The 
actual value of the APC output pin corresponding to this signal 
will now be displayed on the right side of the Value push button. 
If desired, this value can also be displayed graphically. 

− it is possible to connect more output pins to the IN pins of the 
DRTRA block by using MUX blocks. You can control the 
operation of the MUXs from the DDCTool by signals 12116 and 
12117 and function block DRREC. 

− if you want to monitor an output pin that is not connected to an 
IN pin of the DRTRA block then you can connect the desired 
output pin to an IN pin of the DRTRA block by the APC. 

 

 

Monitoring of 
Single APC 
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